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I. INTRODUCTION  

This paper is intended to explain the ways that technology can be used in mediations (4-way 

meetings, mediations, Collaborative Law Process, etc.) to enhance and improve the way that the 

mediation is delivered to the clients.  Since introducing technology into the boardroom, I have 

found that not only are the lawyers more prepared for each meeting, but the clients are better able 

to follow the progress of their matter from start to finish.  This paper will focus on introducing the 

use of mindmapping software as well as the use of other technology within each mediation session 

to achieve these goals.  Adding technology can also assist to keep the parties focused.   Counsel 

can use a monitor in the boardroom to direct the parties’ attention to the topics they wish to cover. 

 

Many of you may still use the ol’ pen and paper to take notes in mediations.  On the other hand, 

many of you may already have introduced technology into your boardroom for use in mediations or 
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otherwise, but may use a word processing software to take your meeting notes.  I was a flip-charter 

in meetings (a form of “pen and paper”).  I knew that I wanted to introduce technology, but knew 

that word processing software was not going to meet my needs.  There’s a reason I used the flip 

chart – it has many benefits, such as: 

 

• One set of meeting notes being taken 

• See all of the notes from the discussions as the meeting progresses – tape each page on 

the wall 

• All eyes focused on one spot 

 

I wanted an alternative to the flip chart.  When I learned about mindmapping software, I realized 

that this was an ideal alternative to the “pen and paper” mode.  I wanted to add the efficiencies of 

technology without being relegated to word processing. 

II. MIND MAPPING 

Since the day that I was introduced to the mindmapping software program called Mindjet and the 

way it can be used effectively in mediations, I have been asking myself how I ever used the ol’ pen 

and paper for so many years!  It was through sheer luck that I discovered the software.  At an 

annual networking forum for the International Academy of Collaborative Professionals, I attended a 

seminar about unleashing creativity within the Collaborative Process; it was intended to help 

counsel to “think outside the box” when brainstorming options for resolution.  Of course, in any 

mediation, not just in Collaborative Law, counsel are always seeking to assist clients to brainstorm 

settlement options. 

 

One technique the seminar encouraged was the use of the right-side of the brain, or the creative / 

artsy side, through the use of mind-mapping.  I had learned about this in elementary school, but 

never thought of the usefulness within the mediation context.  There’s the old-fashioned pen and 

paper mind-mapping, or there’s new-fangled software programs that can take creativity and 

mindmapping to the next level.  Since the very day I learned about the software, I use it daily!  How 

did I exist without it? 

 

Even if you don’t believe that mindmapping will do anything for your creativity, I suggest using it as 

an ideal software alternative to either the “pen and paper” or word processing software to take 
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notes.  When I considered using word processing software for minute-taking, I was worried about 

losing the important concept of being able to see all of the discussions on the flip chart pages as 

the meeting progressed.  That was a significant drawback in any software I had experience using.   

 

In essence, a mindmap is a diagram which allows you to document your notes on one page; by the 

end, it becomes a very large page, but one page nonetheless.  This paper is focused on the 

mindmapping software.  You will learn in this paper about how the software allows you to add an 

unlimited number of topics and sub-topics as the discussions progress, while allowing you to focus 

on any one topic at a time.  As additional ideas pop up, you can type them out, and organize the 

thought later.  As your expertise increases in using the software, you gain an appreciation for how 

dynamic and extensive the program truly is. 

A. History Of Mindmapping 

A mindmap is defined by Wikipedia as “a diagram used to represent words, ideas, tasks, or other 

related items linked to a central key word or idea”.   It is, in essence, a graphical way of taking 

notes.  Although this technique has been used for centuries, the modern mindmap to which I refer 

in this paper was developed in the early 1970s by Tony Buzan, a British popular psychology author, 

primarily an expert on brain development.  Based on his observation that our brains do not process 

information in a linear way, mindmapping allows us to use words, images, and color in an effort to 

engage the right side of our brains in what is normally considered a left-brain task: organizing 

information. 

B. Creativity And Mind Mapping 

Buzan claims that by using a mindmap to capture your thoughts, it allows you to tap into 99% of 

your unused mental potential.  Is this true? In my experience in using the mindmap in Mediation, 

my ability to “think outside of the box” has increased exponentially.  What will your experience be? 

 

Buzan insists that instead of being linear in your thoughts, creating outlines filled with roman 

numerals, paragraphs, and indentation, and building your ideas page by page, you should become 

“radiant” in your thoughts: start with a central idea, branch your main points from that central 

point, then each sub-point creates branches and twigs.  He calls this concept “Radiant Thinking”.  

The main advantage to this concept is being able to have everything on one page.  No more page 

flipping, or sorting through notes. 
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The focus of the mindmap is on the visual presentation of ideas.  Buzan claims that not only is it 

important to create the structure of the mindmap, but it is also important to add images and colour 

to our page.  Think of the flip chart or your handwritten notes.  For the flipchart: Do you change 

colours after each topic? I sure did.  It was for visual effect, and ease of reference across the room 

of flip chart pages to be better able to see which pages and topics are related.  For the handwritten 

notes: Do you highlight important concepts or mark certain items with red or other bold coloured 

ink? It’s to draw attention to certain items.  Bring that concept into the mindmap; the need for 

visual effects is similar. 

 

When brainstorming, a mindmap allows you to quickly get your ideas from your head to the page.  

No need for full sentences; just get the idea down quickly.  Mindmapping lends itself to free-

association.  Record your ideas, then figure out where they should go within the map.  Draw 

connections that you otherwise wouldn’t have made.  In mediations, there can often be great 

dialogue happening, and it can be difficult to get all of the ideas down as they are being discussed.  

Mindmapping can assist in lessening the words on the page (no sentences needed), and in just 

getting the concepts down and worrying about organization and details later.   

C. What Is Mindjet? 

The software program that I use is called Mindjet.  There are other mindmapping software 

programs available, which I will talk about later in this paper, but this was the one that seemed to 

be the best suited for my style preference.  It is straight-forward (after playing around with it for a 

few days), clear, and follows a logical pattern (even when I force myself to use the right-side of my 

brain, my logical/linear left-side needs to be massaged a bit).  Below I have outlined many of the 

features that I have found to be helpful for use of the software particularly in mediations.  This 

paper focuses on the desktop software, which is a program loaded on your computer.  See below 

for the discussion on the web-based program which can be used from any computer. 

 

The idea is to start with a Central Topic, and add branches off that central topic as the parties 

develop their agreement.  You can add attachments, links to websites, notes, comments, task 

items that can link to your Microsoft Outlook, images, labels, and more.  I often will drag-and-drop 

topics from one branch to another to rearrange as the discussions unfold in the meetings.  

Sometimes there’s too much information on one page, so you can either collapse part of the 

mindmap to focus on one specific topic, or even better, click on the topic and view it on a page 
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alone.  Manipulating the data becomes very slick and easy as you become more accustomed to 

using the software. 

 

Below is an example of a mindmap without any content attached, just to give an idea of how it 

looks visually: 

  

 

D. Using Mindjet 

i. Getting Started 

There are a few key commands that you will need to know in order to create your mindmap.  Of 

course, you can use your mouse to create the mindmap, but if you are in a settlement meeting, I 

would recommend that you learn 3 easy keyboard shortcuts – enter, insert, and delete. 

 

Insert New Branch 

If you start a new map with only a central idea as the starting point, you will need to add branches 

to it.  To insert your first topic off the central idea, click on the central topic and click “enter”.  A new 

“main topic” will appear.  To add more branches at the same level, click “enter” again.  You could 

also use your mouse and click on the Home tab, “insert new topic”.  Use the “enter” key anytime 

you need to add a new topic at the same level as the previous topic. 
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Insert New Sub-Topic 

Once you have one topic, you can add as many sub-topics as you need.  To insert a sub-topic at the 

next level, click “insert” on your keyboard, or go to the Home tab, and click “insert new sub-topic”.   

 

Delete Topic 

You can press the “delete” key to remove any topics or subtopics.  If you accidentally delete a topic, 

click “undo” under the Quick Access tool bar, or press Ctrl + Z. 

 

 
Insert Floating Topic 

Inserting a floating topic can be a handy tool because it allows you to add a topic without 

committing to where the branch will be organized.  It “floats” on the map.  Once the thought is 

organized, you can drag-and-drop it to any branch.  I find this tool helpful in such cases where one 

party may go off-topic and need to discuss an item, and counsel may have difficulty figuring out 

where to place the thought or topic.  The floating topic allows you to get the idea down without 

worrying about organization until there is a break in the flow. 

 

Organizing the Mindmap 

During or after a meeting, you may want to change the way the branches are organized.  You may 

have placed a topic under the wrong heading – it’s easy to organize the mindmap later by selecting 

the branches you wish to move, then dragging-and-dropping it/them to a different location.  The 

software is smart in that it will have a translucent red line to show you where you will be dropping 

the branch as you drag it around the map.  If you drop it at the wrong location, just re-select and 

drag it somewhere else! 

 

  

Sub-Topic 
“insert” key 

Topic 
“enter” key 
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Inserting a Boundary 

Sometimes one topic can appear to blend into another because the branches are close to one 

another.  I often use the “insert boundary” feature because it allows the branches to feel distinct.  

There are a number of different boundaries to choose from.  Click on the Insert tab, then Boundary. 

 

Inserting a Relationship 

The Relationship button is right next to the Boundary button in the above explanation.  It allows you 

to connect two branches together to show that one relates to the other.  For example, you may 

want to relate the discussion about commercial property in one section (division of property) to the 

discussion about the rental income which arises from that property in another section (spousal 

support). 

ii. Preparations Prior to First Mediation 

I have developed two templates for use within the Collaborative Process and Family Mediation.  

You may not need to do these preparations if you are in a traditional mediation.  In that case, you 

may wish to start the meeting with a blank “new document” which simply starts with the central 

idea, or you may want to customize your template for your practice area.   

 

I usually start with using my “basic template” for the first meeting, which is pictured below.  I would 

change the central topic to read either “Collaborative Divorce” or “Divorce Mediation”.  Outside 

these processes, you may wish to have the central idea read “Mediation between…” and have the 

rest remain blank: 

Above is my initial template I would use for Collaborative Law/Mediation meetings.  My second 

template will be discussed later in this paper.  
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Based on my meetings with my client(s) as well as my meeting with opposing counsel (in the 

Collaborative Process), I am usually able to complete many of the family details, add in the first 

meeting date at least, and start to insert some of the goals and the topics for discussion.  If you 

prefer to build the entire mindmap from scratch with the clients and opposing counsel in the room, 

you may want to simply start with this type of template blank at the first meeting, and insert details 

as you go with all parties present.  It depends on your style.  I prefer to work together with the other 

Collaborative lawyer on the file to complete as much of the introductory details as possible prior 

the first meeting.  I find that clients are appreciative of this prep. 

iii. First Mediation 

Certainly, if you have not done any prep on the template at the first meeting, you would start out 

the mediation by adding in the details on the left side of the above template, then start adding to 

the list of goals and topics for discussion.  If you are outside of the Collaborative Process or 

Mediation Process, you may prefer to skip the “goals” portion.  The “topics” list is an excellent way 

for all participants to stay on top of the items for resolution. 

 

Priority Icon: Once the topics have been listed, I recommend taking a moment to prioritize the 

issues to determine the order the topics will be discussed.  Keep track of this by using the “priority” 

icon on the Home tab to prioritize the topics.  It keeps everyone on track as to the order that the 

parties want to talk about certain topics.  In subsequent meetings, parties can review and revise 

priorities as needed. 

iv. Subsequent Mediations 

I believe that one of the most important things to keep in mind when using Mindjet is that as you 

progress through a number of meetings with the same parties, any part of the mindmap can be 

revised as needed, with the click of a button.  Using the flip chart, I found it very difficult to keep 

track of the most recent priorities of the parties when each meeting would start with new series of 

flip chart paper; in my experience, the continuity from meeting to meeting was lacking.  I use two 

methods to preserve the ideas from meeting to meeting: (1) At the start of each meeting, click on 

“File/Save As” and mark the current meeting date in the file name; if you need to refer back to a 

previous meeting, it will be preserved in a separate file.  (2) Create minutes at the end of each 

meeting which will be printed and filed for ease of reference especially for those who don’t have 

the software at home.  The final version of the mindmap will contain all of the discussions as well 
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as all of the most recent points of agreement.  At each meeting, if one agreement is superseded by 

another, simply delete the old and replace with the new. 

 

Once you are ready to begin discussing your first topic, I simply copy and paste each topic as a 

main branch off the central idea, as below: 

 
The second template I created includes many topics that parties would customarily want to 

discuss; this template becomes a type of checklist for me to review before we complete a topic, to 

ensure that all items have been covered.  Of course, not all these topics apply to each case, which 

is why I do not use this template as my “starter template”.  In order to create this template, I 

reviewed my precedent Separation Agreement, and inserted many of the topics into the template.  

It is very important that before you start to use the software in an actual meeting, you become 

familiar with how to use it, but also that you create a template that works for you. 

 

Below is an example of one topic that I have in this second template to use as a checklist.  As you 

can see, it would be presumptuous to use this as a starter template, as many parties would not 

want to include all of these topics in their parenting plan.  This is why I use this template simply as 

a checklist to ask parties whether they want to discuss these items.  It avoids the situation where 

counsel has to return to the clients after meetings have ended to ask about some detail that was 

neglected during the meetings.  I know I often had this occur (usually it was the topic of CPP credit 

splitting which I used to inevitably have to contact clients about later because we would forget to 
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discuss the split or waiver).  I have a similar completed branch for child support and division of 

property. 

 

 
 

Tags: As meetings progress, it’s easy to keep track of what was discussed at each meeting.  You 

can customize tags to add to any branch – this is essentially a way to categorize the branches.  

Under the Insert tab, select Tags, then click on “Add new tag” and call the Group “Date of Meeting” 

or “Meeting” – the Name is the actual meeting date.  Once created, you can right click on any 

branch (or select a number of branches) and click Tags, then select the correct meeting date.  It is 

possible to add more than one tag to any topic, so if you discuss division of property over a number 

of meetings, you may add more than one “Date of Meeting” tag to any topic or sub-topic.  If you 

want to view all of the topics which were discussed at a particular meeting, simply click on the 

Home tab, “Marker Index” and it will bring up any tags or icons you have added to your mindmap.   

 

See below for example:   
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“Show Branch Alone”: Sometimes as more and more information is added to the mindmap, the 

screen can start to be cluttered.  There is a feature that allows you to view only one topic on the 

screen at a time under the View tab called “Show Branch Alone”.  I have outlined the advantage of 

having all the notes on one page.  If the map is in the “collapsed” view (all sub-topics are hidden 

from view), the map may be viewed on one screen.  However, as the discussions progress and the 

notes expand, in my experience the parties have a difficult time focusing on a topic if there are too 

many words or topics on the page.  This is why I often use the “Show Branch Alone” feature.  To get 

out of this view, click on the button “Show One Level Up” which takes you back to the main map.  I 

use the feature of “Show Branch Alone” as well when I create the meeting minutes, as will be 

discussed below. 

 

Focus on Topic: Under the View tab, click on “Focus on Topic” to quickly expand one topic and view 

the sub-topics below.  It is easier than clicking the + and – signs repeatedly! 

 

Progress Icon: As you move through the topics, it’s helpful to keep track of the progress that the 

parties are making by using the “progress” icon.  It is a circle that starts out with a white 

background to mark the item as “incomplete”, then progresses through one-quarter, half, three-

quarters complete, then the fully filled in icon with a checkmark in the centre shows the item as 

“complete”.  At the end of the settlement meeting(s), all of the topics should be labeled as 

“completed”.  This is also your final checklist to ensure that nothing has been left without 

resolution. 
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Decision & Question Icons: There are a number of available icons in the software, but two that I use 

often are “decision” and “question”.  The decision icon is used to mark any agreements the parties 

make on a particular topic.  The question icon is used to keep track of any topics that require follow 

up at a future meeting.  The “Marker Index” under the Home tab can used to find all of the icons 

that you have scattered throughout the map.  At the beginning of each meeting, I typically review 

any outstanding “questions”.  When drafting the Separation Agreement, it is easy to find all of the 

most current “agreements” between the parties by finding all the locations in the mindmap where 

the gavel is placed. 

 

These two icons are shown below: 

     “decision”  “question” 

 
  

Attachments and Hyperlinks: Two of the items that I insert regularly into my mindmaps are: 

attachments and hyperlinks.  Under the Insert tab, select either of these buttons either to attach a 

document (Word, Excel, PDF, etc.), or to add a link to a website.  When you click on the link for 

either function, it will open up on the left side of the screen inside Mindjet, but can also be opened 

full-screen by clicking on the icon inn the top-right corner of the attachment / webpage.   

 

Examples of useful attachments are: budgets, family property distribution spreadsheets, child 

support summaries, and financial disclosure (such as any scanned documents you may have on 

your computer for the parties: income tax returns, pay stubs, property appraisals, bank statements, 

etc.). 
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Examples of useful links are: child support online lookup, registered pension information website, 

Canadian Black Book valuation website, school information website, etc. 

v. Minutes of the Meetings 

After each meeting, the minutes literally only take minutes to complete (once you’ve had some 

practice).   

 

Review of the Mindmap 

I recommend reviewing the mindmap to ensure that all of the tags (meeting date) and icons were 

inserted where appropriate.  I also add any attachments or hyperlinks that I feel would be helpful 

for the parties.  Sometimes things move quickly in the meeting,   and there is no time to be tedious.  

See Schedule “A” attached to this paper for a sample set of minutes from a real case, which facts 

have been modified for privacy and confidentiality purposes. 

 

PDF Minutes – Printable  

There’s the easy, and the very easy way to do minutes.  This first method is the easy way, and the 

one that can be easily printed for the file.  The minutes entail a number of “screen shots” of the 

mindmap.  Even after the first meeting, the mindmap will be too large to print on one letter-sized or 

even legal-sized paper.  I recommend picking a topic, expanding that topic, then creating a PDF of 

that expanded topic.  The first page of my minutes is always the overall view of the mindmap, with 

all branches collapsed, or perhaps the “meeting dates” branch and the “to do list” expanded.  For 

the minutes of the first meeting only, I keep the left-side of the mindmap expanded for reference.  

If it is not referred to after that, it stays collapsed for the subsequent minutes.   

 

Each branch, including the goals, list of topics, and any topics that were discussed that meeting will 

be a separate page of the minutes.  In order to do so, I select “Show Branch Alone” under the View 

tab, then choose “Expand All Branches”.  Depending on the size of each discussion item, you may 

have to expand only certain sections to fit on one page for the purpose of the minutes.  Once I am 

satisfied with the branches to be on one page of the minutes, under the File tab click “Export”, then 

“Export as PDF”.  This feature will allow you to create a PDF version of exactly what is on your 

screen.  Expand any of the branches you want shown as part of the minutes, and collapse the rest. 

 

I will repeat this step for each branch which has been discussed in that particular meeting.  Each 

PDF will be a separate document.  All of the pages together become the minutes of your meeting.  
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Include any attachments to your minutes as necessary.  In keeping with the theme that all 

documents within a file are scanned to the network, my assistant will scan all of the pages 

including any attachments and save them to the network.  This creates a time-stamped record of 

the discussions during that meeting.  This is important because if you modify the mindmap in 

subsequent meetings, it is often beneficial to have a paper record of the discussions at previous 

meetings that may have been over-written. 

 

For subsequent meetings, I re-open the saved mindmap, do a “save as” (as discussed above), and 

continue to build the mindmap.  If parties change their mind on a particular issue, I overwrite the 

old idea with the new idea.  This prevents confusion when it comes time to drafting the Agreement.  

I found that when using the flip chart, and creating static minutes after each meeting, it became 

confusing to determine the most recent decision of the parties on a particular topic by the time the 

settlement meetings came to a close; if the parties had revised their thoughts at a subsequent 

meeting, there was no document to which I could refer which showed their most recent decisions 

on all topics.  If you delete the old idea, and replace it with the new idea on your mindmap, you will 

never again have to wonder about the most recent decision of the parties.   

 

PDF Mindjet Viewer – Non-Printable 

The easier way to create your minutes takes about 30 seconds, but is not easily printable for your 

file.  In this method, you create a clickable mindmap to be sent to your clients in a PDF format.  By 

going to the File tab, and clicking on Export, then “Export as Mindjet Viewer (PDF)”, you can email 

all participants a mindmap which they can open with Adobe Reader (the free version) and they can 

click on any branch to expand or collapse it.  This allows the participants to review any part of the 

mindmap.  It is not printer-friendly, but it allows them to expand and collapse branches.  The 

attachments and hyperlinks will appear on this PDF, but will not be able to be opened from the 

PDF.  Therefore, you will have to send any attachments by email.   

 

I used to do the easy method, but more and more I am now opting for the easier method.  My 

clients prefer the clickable PDF (2nd method).  Perhaps you want to send both versions to the clients 

– the static PDF and the dynamic one. 
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E. Other Mindmapping Software 

i. Mindjet 

Mindjet is only one of many types of mindmapping software available on the market today.  It is 

the only software with which I have first-hand experience.  I chose this software because it was 

recommended to me by a mediator who used the software in her mediation practice on a daily 

basis.  She recommended it because it has the visual effect of a mindmap, but the framework for 

the map seems to be most conducive to counsel whose brain is accustomed to a more linear 

approach. 

 

Mindjet has a few purchase options: 

 Individuals Business Web-based 

Monthly $15/month/user $30/month/user $15/month/user 

Annual (1st year) $90/year/user $270/year/user Unknown 

Annual (year 2~) $180/year/user $190/year/user Unknown 

 

Mindjet for Business and for Individuals both offer the desktop software (Windows and Mac 

versions) as well as the web-based software.  The main difference between the two is the number 

of users you can share your mindmap with over the web.  Both versions come with the web-based 

program included.  To share your mindmap, simply login to your mindjet.com account, upload your 

mindmap to the site (or create a new one), then click on “share”.  If you have the Individual 

account, you may invite 2 people to view your map at a time, under the Business subscription, you 

have unlimited sharing ability.   

 

The nice feature about the web-based program is that you can use any laptop to access your 

mindmap and the software – the program is not loaded onto your computer.  Therefore, if you want 

to share the mindmap with clients, and have them either view and/or edit the mindmap, all that is 

required is an Internet connection.  Similarly, if you have a mediation at another office, as long as 

they have a computer they can connect in the boardroom to a monitor, you can use their 

technology without lugging your computer all over. 

 

This program is also available to purchase as a perpetual license.  It is $360.00 for either Windows 

or Mac platforms.  For the first year after your purchase, you receive a free subscription to the 
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Mindjet for Business.  You do not receive any software updates except in the first year.  As well, 

after the first year your web-based account becomes inactive. 

ii. iMindmap 

iMindmap was developed by Tony Buzan and has a much more “artsy” and “colourful” feel than 

Mindjet.  The software is purchased based on the number of users and the version you wish to 

download.  The free version has a couple of basic mindmap templates, but is very limited in its 

scope.  The Home & Student version is the next step, and costs $67.00 for one user; the price per 

user goes down as you add users.  The Ultimate version is the full-featured version and costs 

$256.00 for one user.  Buzan has moved into the “cloud” and offers an online version for $99.00 

for one user. 

 

Below is a screen shot of a sample iMindmap: 

 

iii. MindMapper 

MindMapper is a Windows-based software that offers more than just mindmapping.  The user can 

also create flow charts, organizational charts, and more.  It is likely that some of the other software 

programs can also produce these results, but it is this software in particular that promotes all of the 

features rather than just mindmapping.  As such, I would expect that the software has a wider 

focus than simply mindmapping.  The software is available in the Professional version for $249.95 

or the Standard version for $124.95. 

 

Below is a screen shot of the software:   
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iv. Mind Meister 

This software is exclusively Internet-based.  It offers three maps for free, and after that the user is 

required to purchase a subscription for the software.  There are three versions: Personal for $4.99 

per month (single user only), Pro for $9.99 per user per month, and Business for $14.99 per user 

per month.  

 

Below is a screen shot of this program: 

 
 

The above comparison of software programs is not intended to recommend any one software 

program over another.  This section is written simply to encourage you to find the program that 

works best for you and your practice.   
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III. SETTING UP YOUR BOARDROOM 

To be able to have all participants in the mediation looking at the same monitor, it is essential to 

have some type of projector to display the content of your screen either onto a wall or onto a 

monitor which is large enough so that all participants are all able to focus on the same view.  I have 

a rather small boardroom; for me, the best option was to purchase a 42” TV and mount it onto my 

wall.  I place my computer on a table under the monitor, plug it into the TV with an HDMI cable, and 

use a wireless mouse and keyboard to control the computer.  The keyboard and mouse is key to 

ensuring that everyone is focused on the same page.  If the person typing is focused on a laptop 

screen rather than the monitor/projector, then it will feel as though you are just as removed from 

the conversation as if you were up at the flip chart; this is something that can be easily avoided.  As 

well, the laptop can be a physical barrier on the table that causes the person typing to be 

“separated” from the rest of the table.  Small points, but it does make a difference. 

IV. INTERNET RESOURCES  

Now that I have a laptop set up in my boardroom, I find myself toggling between my mindmap and 

the Internet quite often for various reasons.  For example, in one session, parties had a detailed 

question about the CPP credit split on breakdown of marriage.  We were able to look it up on the 

Internet and have our answer immediately.  In another case, we needed information on the 

children’s school calendar for that year.  Or, you may want to look up the black book value on a 

vehicle. 

V. CHILD AND SPOUSAL SUPPORT CALCULATOR 

If you conduct dispute resolution processes for divorcing families, many of you use a software 

program to calculate child and spousal support.  I have Child View installed on my laptop, and find 

it useful to be able to open the program and to manipulate the data right there in the meeting.  For 

example, we can change incomes to see the different child support that would result or the 

different proportionate shares of Special Expenses that each party would pay.  As well, we can view 

any available reports which may be helpful for discussion purposes during the meetings.  These 

reports can span across topics beyond just child support.  For example, when discussing spousal 

support, the Cash Flow Calculator can be very useful.  Instead of simply offering to complete the 

report after the meeting and attaching it to the minutes (which often can cause mass confusion 

when clients try to read the report on their own), you can create the report and review it on-screen 

during the meeting.  The more immediate the results, the more relevant it seems to be for the 

clients.   
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VI. PROPERTY STATEMENTS 

I used to wait until after our first discussion about the division of property to create the property 

spreadsheet, and attach it to the minutes.  Now that I bring the laptop into the meetings, I simply 

open the spreadsheet precedent I have saved on my network, and start building the spreadsheet as 

the various property items are discussed.  This draft spreadsheet can then be attached to the 

mindmap and updated at each meeting.  I find that when the spreadsheet is created after the 

meeting, that parties were more confused about the content because they are not engaged in the 

creation of the spreadsheet. 

 

If you are the type to do a lot of prep before meetings, you may want to start filling in the 

spreadsheet with assets and debts that you are aware of prior to discussions starting.  My clients 

complete a detailed questionnaire prior to engaging in any mediation; therefore, I have a lot of 

information which I could fill into the spreadsheet before our first meeting.  Especially if you are 

engaged in a litigation matter, you would likely have a lot of the disclosure ahead of time, and quite 

possibly would have a draft Matrimonial Property Statement already started.  An idea is to project it 

onto the monitor in an editable format (Word, Excel, etc.) so that it can be edited as the meeting 

progresses. 

VII. REVIEW OF BUDGETS 

If you encourage your clients to send their budgets to you electronically, you can review them on-

screen during a settlement meeting.  This is helpful because the person who created the budget 

can explain each line, and the budget can be revised if necessary as it is being discussed.  Once 

again, all eyes are on the same page and hopefully on the same line item as the discussion 

progresses.  How often do you experience one party moving ahead to another part of the document 

and therefore not listening to the person as they explain their reasons for the expenditure(s).  In the 

end, the team has a completed budget that can be made part of the minutes, without the need for 

further revisions post-meeting. 

VII. REVIEW OF FINANCIAL DISCLOSURE 

Since my office has been moving toward a more paperless approach (we are far from truly being 

“paperless”, but more so “less paper”), we scan every piece of financial disclosure as it is received, 

for both parties.  During a settlement meeting, I open the client’s folder on the network so that I 

can quickly open any financial disclosure documents needed.  Any documents are easily shared, 

then, by email, or printed for either party to take home to review. 
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From a space-saving perspective, it is great to have all of the disclosure in electronic format, 

because the physical file will likely be reduced exponentially. 

IX. REVIEW OF DRAFT AGREEMENT 

In some cases, you may want to have the parties come together for one final meeting once the 

Separation Agreement has been drafted in order to review the Agreement together.  This is often 

done especially in the Collaborative Process.  It is helpful to project the Agreement onto the screen 

so that, again, all eyes are focused on the same paragraph.  Reviewing it electronically also allows 

counsel to revise any part of the Agreement as it is being discussed.  Then, revised wording can be 

reviewed together, and further revisions become less likely to be necessary. 

X. Conclusion 

The use of technology within the boardroom has opened up many opportunities which did not exist 

before such integration.  In my experience, it has enhanced my client’s experience in mediations 

significantly, both in the amount of preparation that is done before meetings in inserting 

information into the mindmap as well as in the way that documents can be displayed on-screen 

and manipulated during the meetings to arrive at a finished product on the spot. 

 

I find myself toggling between the mindmap and other pieces of information regularly during the 

meetings, whether it’s the parenting calendar, a website with information requested by the parties, 

financial disclosure, budgets, or otherwise.  All of the information is at my fingertips as it is needed.  

This change in structure of my boardroom fits in perfectly with my concurrent goal of becoming 

more paperless in my office.  Can you imagine going back to the ol’ pen and paper?  
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Collaborative Divorce of
Tony and Ann Smith

Goals and Interests
of the Parties

Meeting: April 25/13

Topics for Discussion
During Mediation

Meeting: April 25/13

Parenting Plan

Meeting: April 25/13, April 27/13

Meeting Dates
April 25, 2013 @ 1:30-3:30
April 27, 2013 @ 1:30-3:30
May 5, 2013 @ 9:30-11:30

To Do List

Tony
Bring in recent paystubs with YTD

Ann
Bring in recent paystubs with YTD

Stephanie Dobson
Jane Doe

Family Details
Meeting: April 25/13

Date of Cohabitation
January 1996

Date of Marriage
March 15, 1996

Date of Separation
January 1, 2011

Date of Divorce
Still married

Last Province of Joint Residence
Alberta

Details of Children
Brittany Ann Smith, born April 15, 1998

Robert George Smith, born March 19, 2000

Parties' Lawyers

AnnUnknown

TonyUnknown

Introductory Items
Meeting: April 25/13

Reviewed Mediation Principles
Reviewed & Signed Mediation Agreement

****Names have been altered
for privacy and confidentiality

Example Real Case Completed for Presentation and Minutes.mmap - 12/9/2012 - Mindjet

owner
Typewritten Text
Schedule "A"Sample Minutes

owner
Typewritten Text

owner
Typewritten Text

owner
Typewritten Text

owner
Typewritten Text

owner
Typewritten Text

owner
Typewritten Text



Goals and Interests
of the Parties

Meeting: April 25/13

As Parents

Both be active in the kids' lives

Remain flexible in parenting schedule

Work together if need changes to schedule

Be able to discuss holiday plans as they arise

Ensure that any plans that are made are
with the intention that kids will do
whatever is most fun for them, not for
parents

Maintain good communication between parents

Keep kids out of any conflict

Ensure that the kids know that they are
free to go between each parent without
fear of upset / emotion

Ensure that the kids have a similar
standard of living between the homes

Consistencies between
households re: rules

Homework at each house

Ensure that the kids don't start choosing
where they want to live based on how
each party parents

Both parents contribute to the kids'
needs regardless of which household
they are in

Raise the kids with values held by both parents

Avoid the "Disneyland" parent syndrome

Give kids all the opportunities they want / need

If better to move out of Lloyd for these
opportunities, then need to look
seriously at the possibilities

Process of Separation

Remain "fair" with each other

Keep business running

Work together, not against each other,
to have Ann bought out of the business

Keep it simple

Get loose ends tied up and formal
agreement completed

Keep things "clean"

Keep "greek chorus" out of
the conflict / discussions

Keep decision-making
between parties

Help to be steered in the right direction

Start off as separated parents on a good footing

Avoid any negativity / negative stigma
Young when started dating

The relationship just ended because
grew apart - doesn't have to be negative

Personal

Maintain good relationship between parties

Get some space from Lloydminster

Ann decided to
move to Edmonton

Ann would like to be in a position to buy
a house in Edmonton eventually

Example Real Case for Presentation.mmap - 12/9/2012 - Mindjet



Topics for Discussion
During Mediation

Meeting: April 25/13

Parenting Plan

Regular Schedule Flexibility re: changes

Holiday Schedule

Decision-Making

Child Support

Medical/Dental Insurance coverage

Incomes of parties

Monthly Support Section 3

Special Expenses Section 7

Travel Issues

Division of Property

Valuation Date

Ann to find out the date when her
individual bank acct was opened Likely use this date

List of Assets / Debts

Matrimonial Home

Time Share

Sell?

One party to keep?

Keep as joint - maintain
alternating years?

Family Business

Vehicles

Household Contents

Bank Accounts

Credit Cards

Line of Credit

Spousal Support
Waiver

Example Real Case Completed for Presentation and Minutes.mmap - 12/9/2012 - Mindjet



Parenting Plan
Meeting: April 25/13, April 27/13

Parenting Schedule
Meeting: April 25/13, April 27/13

Holidays

Christmas Christmas 2013 and beyond

Ann has Kids from Dec 24-Jan 1

2013 and odd
numbered years

Tony has Kids from Dec 24-Jan 1

2014 and even
numbered years

Easter

2014 and even numbered years Kids with Tony

2015 and odd numbered years Kids stays with Ann

Defined as Good Friday to Easter Monday

Thanksgiving

2013 and odd numbered years Tony has Kids

2014 and even numbered years Kids with Ann

Defined as Friday thru Monday

Summer

In the past, Tony's parents have
traditionally taken grandkids to the cabin
near Prince Albert

Usually in July

Both parties ok with making this
continue to happen

Ann would like to take Kids to
Newfoundland for wedding

August long weekend

One week trip

Keep rest of summer schedule same as
regular schedule

Let each other know about any extended
holiday plans with or without Kids

Kids's birthday

May 18th Usually on the long weekend

No change to regular parenting schedule

Parent who is not on duty for that day
will have to celebrate with Kids on a
different day

Kids bday party Each plan own on regular parenting time

Mother's Day Ann gets Kids for the day of Mother's Day

Father's Day Tony gets Kids for the day of Father's Day

Long weekend Extend parenting time to include the holiday day

Flexibility
Consider parents' work schedules

May need to re-arrange weekends if one
parent ends up with many in a row

Flexibility

Weeknight Parenting Schedule

Regular Schedule

Exchange

Child Support
Meeting: April 27/13

Tony's Income

Ann's Income

Example Real Case Completed for Presentation and Minutes.mmap - 12/9/2012 - Mindjet



Parenting Plan
Meeting: April 25/13, April 27/13

Parenting Schedule
Meeting: April 25/13, April 27/13

Holidays

Flexibility

If one person wants a change Agreed to make the change happen if it works

If additional time required Be flexible with each other

Weeknight Parenting Schedule

If off early, try to pick up Kids from daycare
Parties are agreeable to this continuing

Ann will pick up Kids from Tony's house

Ann's job ends every day between 4:30
and 5:15 (latest)

Regular Schedule
Tony has Kids alternating weekends

Tony usually has Friday off

Ann usually drops off Kids Thursday
night or Friday morning

Assume that Ann will drop off Kids on
Friday morning unless arrange otherwise

Tony needs some unwinding time at the
end of his 11 days of work

If Tony wants to take Kids on the
Thursday evening, will provide as much
notice as possible, but Ann cannot
guarantee that it will be immediately

At the end of the weekend, will arrange
whether to exchange Kids before or after
supper

Exchange

Ann will drop off at Tony's or Tony will
pick up at Ann's in the driveway (Tony's
preference, not required)

This is Tony's preference while Ann is
living at her parent's place

This may change once Ann moves out

Child Support
Meeting: April 27/13

Tony's Income

Ann's Income

Example Real Case Completed for Presentation and Minutes.mmap - 12/9/2012 - Mindjet



Parenting Plan
Meeting: April 25/13, April 27/13

Parenting Schedule
Meeting: April 25/13, April 27/13

Child Support
Meeting: April 27/13

Tony's Income

Working at XXYY Oilfield Ltd.

Salary $120,000

Bonus annually

Variable amount

Past 3 years
$15,000 annual

Received in April for previous year's service

Bring in paystub for next meeting with
YTD calculations shown

Ann's Income

Retail employee ABC Flower Shop Ltd.

Working part-time for 2 years

Usually 20 hours / week

$15/hour

No bonuses

Bring in paystub for next meeting with
YTD calculations shown

Example Real Case Completed for Presentation and Minutes.mmap - 12/9/2012 - Mindjet
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